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Your Apricot PC and on-line services

Q What is the purpose of this booklet?

This short booklet answers the questions that our customers most
frequently ask about using a modem to connect their computers to
the telephone network.

To get the most out of this booklet, you should be familiar with
basic Windows 95 features such as the desktop and the taskbar, and
with actions such as pointing and clicking with the mouse. If these
things are unfamiliar to you, refer to the Introducing Microsoft
Windows 95 book that came with your computer.

Q Why would I want to connect my PC to the phone
network?

By connecting your computer to the phone network, you can access
a wealth of information and on-line services.

Using the software we provide, together with the facilities included
in Windows 95, you can set up your computer to act as an
answerphone and a fax machine.

Another good reason for connecting to the phone network is to get
access to the Internet, and in particular the World Wide Web,
which you’ve probably heard so much about.

Once you have Internet access you also have the ability to exchange
electronic mail (e-mail) with other people who are also on the
Internet.

Q What is the Internet?

The Internet is a global network of computers that allows many
millions of computer users (like you) to share and exchange
information. Hundreds and thousands of computers linked to the
Internet hold huge quantities of information that you can access
from your PC.
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Q What is the World Wide Web?

The World Wide Web (abbreviated WWW or W3 or just called
“the Web” for short) is largely responsible for the recent popularity
and success of the Internet.

The Web is a vast collection of “pages” all linked together via the
Internet. A typical Web page contains words and pictures – often
like a magazine page – but also interactive content such as
animations, video clips, and audio segments. To view these pages,
you need a special program called a Web browser. Hundreds of new
pages appear each week. By clicking on words, pictures and icons
within the browser, you can navigate from one site to another
quickly and simply.

Q What do I need to use these services?

Nothing! Or rather, we’ve provided everything you need, pre-
installed on your computer.

♦ To physically connect your PC to the phone network, we’ve
fitted a modem inside your computer (applies only in certain
countries).

♦ To get you connected to the Internet, we’ve provided the
Infotrade Internet service (this offer applies only in the United
Kingdom). And to navigate through the Web, there’s the
Microsoft Internet Explorer Web browser.

♦ To receive voice and fax messages, we’ve provided the
Answerphone program, which works together with the
Microsoft Fax service already included in Windows 95.

♦ To review the e-mail, voice and fax messages you’ve received,
we’ve provided the Message Centre program. You can also use
the Message Centre to compose and send e-mails.

The Infotrade Internet, Answerphone and Message Centre software
are all pre-installed on your computer’s hard disk, ready to use. The
Answerphone and Message Centre are part of the Easy Manager
software collection.
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Setting up your modem

Q What is a modem?

The telephone network was originally designed to be good at
transmitting human speech, but computers don’t communicate by
making noises at each other the way people do. A modem is simply
a device that translates computer signals into sounds that the
telephone network can convey, and back again.

Q How do I connect the modem to the phone network?

A modem cable is supplied with your computer. You plug one end
into the modem socket on the back of the computer, and the other
end into a normal telephone wall socket. The Welcome Mat that
came with your computer illustrates this procedure.

Hint
You can’t make or receive telephone calls or faxes while your PC is
connected to the Internet, unless you have more than one phone line.

Using Infotrade Internet

Q What is Infotrade Internet?

Infotrade Internet is an Internet service provided by Infotrade
Limited, a subsidiary of Mitsubishi Electric, the makers of your
Apricot PC.

Infotrade also offers a variety of personal finance services. However,
these on-line services are entirely optional and separate from the
Internet service.

To find out more about the Infotrade Internet service, double-click
the Infotrade Internet Help icon on the Windows 95 desktop.
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Q Are there other Internet services I can choose?

Although we recommend the Infotrade Internet service, and have
made it very easy for Apricot PC users to subscribe to it, there are
other possibilities.

On the Windows 95 desktop is an icon for The Microsoft
Network, which is the on-line service provided by Microsoft itself.
And in the On-line Services folder (also on the desktop) you will
find setup programs for other on-line service providers.

Hint
The icon on the desktop labelled The Internet starts the Internet
Explorer Web browser. Although it has been set up to allow easy access
to Infotrade, it is not tied to any particular Internet service provider.

Q How do I subscribe to the Infotrade Internet service?

To subscribe to our Internet service you need to run the Infotrade
Internet And Fax Setup wizard, then go on-line to register your
details with Infotrade. If you use the wizard, Infotrade Internet and
Microsoft Fax services are set up automatically at the same time.

Before you begin, make sure you know your Infotrade Account
Number. This number can be found on the Infotrade Internet
leaflet supplied with your Apricot PC, and takes the form of a single
letter followed by seven digits; for example: D1234567.

To set up the Infotrade Internet and Fax services

1. Double-click the Infotrade Internet and Fax Setup icon on
the Windows 95 desktop.

 The first screen of the Infotrade Internet and Fax Setup wizard
appears.
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2. Type your name (if not already filled in for you), your
Infotrade Account Number (identified on the Infotrade
Internet leaflet supplied with this product), and the phone
number to which your PC is connected.

Note
Your fax number is automatically added to all the faxes you send.

3. Click Setup now to continue.

4. Check that the information displayed on this screen is correct.
If anything needs to be changed, click Re-enter information.
Otherwise, click Information is correct to continue.

5. On the final screen of the wizard you are given some advice
about what to do next. Click Finish Setup to complete the
setup.

6. You are now prompted to restart your PC. (If not, you must
restart it yourself as follows: click the Start button in the
Windows 95 taskbar, click Shut Down, select the Restart the
computer? option and then click Yes.)

Once your PC has restarted you can go on-line and register with
Infotrade.



���������	
��
��
���������




��

To register with Infotrade

Before you begin, make sure you know your Infotrade Account
Number and Infotrade password. These are identified on the
Infotrade Internet leaflet supplied with your computer.

1. Double-click on The Internet icon  on the Windows 95
desktop to start Internet Explorer.

 The Infotrade first page appears. (If some other page appears
instead, type C:\INFOTRDI\APRFIRST.HTM in the Address box
and press Enter.)

2. Click the Registration button. The Dial Up Networking
dialog appears.
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3. Type your Infotrade Account Number in the User Name box
and your Infotrade password in the Password box.

Important
Don’t type your own name in the User Name box! Infotrade is
expecting your account number.

4. Click Connect. This connects you to the Infotrade site.

5. On the first Web page, click the Accept button to accept the
terms and conditions relating to the Infotrade Internet service.

6. On the next Web page, click Continue.

 The Enter Network Password dialog appears.

7. Type your Infotrade Account Number in the User Name box
and your Infotrade password in the Password box. Click OK.

8. In the subsequent Web pages, type your name, address, home
and daytime telephone numbers, and credit card details, in the
spaces provided. Click Finish to complete the registration
process.

Note
If you encounter any problems during registration, you can start
over again from the beginning.

9. At this point you can exit from Internet Explorer, or go on to
explore or “surf” the Web.

Q How do I access the Web?

You connect to Infotrade and access the Web as follows:

1. Double-click on The Internet icon  on the Windows 95
desktop to start Internet Explorer. The Infotrade first page
appears.

2. Click the Infotrade logo. The Dial Up Networking dialog
appears.

3. Type your Infotrade Account Number in the User Name box
(if it is not already filled in for you), and your Infotrade
password in the Password box. Click Connect.
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 Your computer connects to Infotrade, and Internet Explorer
displays the Apricot/Infotrade start page. You are now on the
Web!

4. At this point you can do any one of the following:

◊ Click on the Apricot InTouch or the Infotrade logo to
visit these sites.

◊ Choose Web Tutorial from the Help menu to visit
Microsoft’s introduction to the Web, or choose Best of
the Web from the Go menu to discover Microsoft’s
choice of interesting Web sites.

◊ Choose a bookmarked site from the Favorites menu.

◊ Type the URL (uniform resource locator) of a Web site in
the Address box and press Enter.

◊ Click the bar labelled Click here for Infotrade Account
information if you want to check on the status of your
account or change your account details (including your
Infotrade password).
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5. If you want to search the Web you can do this through either
Apricot InTouch or Microsoft, whichever you prefer:

◊ Click the Apricot InTouch logo to go to the Apricot
InTouch home page. Click Exploring the Net to see a
page that includes links to several well-known search sites.

◊ Choose Search the Web from the Go menu to go to
Microsoft’s search site (or click the Search icon in the
button bar).

Using the Answerphone and Microsoft Fax

Q What does the Answerphone program do?

The Answerphone answers your incoming telephone calls
automatically. Calls may be either voice or fax messages.

♦ A voice message (also known as voice mail) is recorded by the
Answerphone and can then be replayed in the Message Centre.

♦ A fax message is received by the Answerphone (using the
Microsoft Fax service included in Windows 95) and can then
be reviewed in the Message Centre.

Note
The Answerphone program does not enable your computer to be used as
a “hands-free” telephone, even if a microphone is attached.

Q How do I turn on the Answerphone?

Initially, the Answerphone is turned off, although it puts its icon in
the taskbar every time you start Windows 95.

To turn on the Answerphone

1.  Double-click the Answerphone icon  in the Windows 95
taskbar.

2.  Click the General tab.

3.  Click the Answerphone is OFF button. The legend on the
button changes to “Answerphone is ON”.
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4.  Click the button below the ON/OFF button to set the
Answerphone to Answer immediately, or Answer after 3, 5 or
10 rings. Again, the legend on the button changes when you
click it.

5.  Click OK.

 For more information, click the Help button on the
Answerphone program.

When an incoming voice message is received, the Answerphone
records it (for up to a maximum of three minutes). Recorded
messages can be played back in the Message Centre.

Q How do I set up the Microsoft Fax service?

The easiest way is to use the Infotrade Internet and Fax Setup
wizard as described earlier in this booklet.

Q How do I set up the Answerphone to receive faxes?

Turning on the Answerphone is sufficient to get it to accept voice
messages, but not fax messages. This is because the Answerphone
uses the Microsoft Fax service, which is initially set not to answer
incoming calls.

To set up the Answerphone to receive faxes

1. Double-click the Answerphone icon  in the Windows 95
taskbar.

2. Click the General tab.

3. Select the Receive incoming faxes option, then click OK.

4. Click the Microsoft Fax icon  in the Windows 95 taskbar.

5. In the Microsoft Fax Status dialog, click the Options menu
then click Modem Properties.

6. In the Fax Modem Properties dialog, set the Answer Mode to
Answer after 3 rings then click OK.

Once received, fax messages can be viewed in the Message Centre.
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Q Can the Answerphone tell the difference between
voice mail and fax messages?

Yes. If you turn on the Answerphone and set it up to receive fax
messages (as described above) it will be able to accept both types of
call. When a call comes in, the Answerphone first plays the default
operator message:

"To leave a voice message, press 1; to leave a fax message,
press 2."

If the caller presses 1 on his telephone keypad, the Answerphone
plays the following outgoing message and then records the call as a
voice mail message:

"I'm sorry no one can come to the phone now. Please leave
your message after the beep."

If the caller presses 2, or if nothing happens after a few seconds, the
Answerphone treats the call as an incoming fax message.

If you attach a microphone to your computer, you can change the
default operator and outgoing messages to suit your needs. Click
Help in the Answerphone program for more information.

Note
Apricot PCs are not supplied with microphones.

Q How do I compose and send a fax?

There are two ways to do this. One way is to use the Compose New
Fax wizard to compose and send the fax directly. The other way is
to compose the fax in a wordprocessor (or similar) application and
then “print” the fax document with Microsoft Fax rather than your
usual printer.

To compose a fax with the Compose New Fax wizard

1. Click the Start button in the Windows 95 taskbar, then click
Programs, Accessories, Fax and Compose New Fax.

2. The first time you use the Compose New Fax wizard, you are
asked to identify the location from which you are sending the
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fax. This question is intended for users of portable computers.
Since you have a non-portable PC, select the I’m not using a
portable computer, so don’t show this to me again option,
then click Next > to continue.

3. Type the name and fax number of the person you want to call.
If you want to send the same fax to more that one person, use
the Add to List button to add their names into the Recipient
list. Click Next > to continue.

4. Select the type of cover page you wish to use from the list of
predefined samples. To take advantage of off-peak phone call
charges, click Options and select the time the fax is to be sent
(remember, your computer needs to be on at the defined time
to be able to send the fax). Click Next > to continue.

Note
You can create your own fax cover page with the Cover Page
Editor, but the procedure is beyond the scope of this booklet. See
the Help in Cover Page Editor for more information.
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5. Type the title of your fax in the Subject box, and the text you
wish to send in the Note box. When you have finished typing
your note, click Next > to continue.

6. If you want to send a previously-created file with the fax,
perhaps containing pictures in addition to text, click Add File
and select the file from the displayed list (you will need to
remember the folder the file was saved in). You can include
several files in the same way. Click Next > to continue.

7. If you are content with the selections you have made, click
Finish to begin the transmission.

 The Microsoft Fax Status window appears and shows the
various stages of the fax transmission.
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 Once the fax has been sent, the modem disconnects from the
phone line and the Microsoft Fax Status window disappears.

To compose a fax in a wordprocessor

1. Use a wordprocessor or similar program to compose the fax
you want to send. When you are ready, click the Print
command in the File menu.

2. From the Printer Name list, select Microsoft Fax and click OK.
The Compose New Fax wizard starts as previously described.
The only difference is that in this case you are not asked if you
want to include a file with the fax.

Q What does a red flashing light on my PC mean?

It means that you have received a voice message, an e-mail or
possibly a fax message. Use the Message Centre program to review
these messages.
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Using the Message Centre for electronic mail

Q What does the Message Centre program do?

The Message Centre is the place where your incoming electronic
mail (e-mail), voice and fax messages are kept for you to review, and
where you can compose and send your own e-mail. The Message
Centre also keeps copies of certain “reminders” set up using the
Media Manager (see the Help in the Media Manager and the
Message Centre for more information).

The Message Centre window indicates the number of messages of
each type. The presence of unread messages is marked by a small
envelope icon.

Note
E-mail, voice mail and faxes can also be reviewed with the Windows
Messaging program included in Windows 95. However, the Message
Centre represents these different messages in a way that is more familiar
to a new computer user.
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Q How does the Message Centre represent e-mail?

The EMail window of the Message Centre shows an In tray and an
Out tray.

♦ The In tray contains all your incoming e-mail plus any e-mails
you are still composing.

♦ The Out tray contains all your outgoing e-mail that is waiting
to be delivered.

Each e-mail item is shown as either an envelope or a parcel,
depending on whether or not a file has been attached to it. Once
you have read an e-mail, the envelope or parcel is shown as having
been opened. All delivered e-mail is shown with a postage stamp
and a postmark.

Q What is my e-mail address?

If you subscribed to the Infotrade Internet service, your e-mail
address is derived from your Infotrade Account Number. For
example, if your account number was D1234567, then your e-mail
address would be D1234567@infotrade.co.uk.

Note
You cannot use your name as your Infotrade e-mail address. For
example, an address such as john.smith@infotrade.co.uk would not be
recognised.

Q How do I compose and deliver e-mail?

Because you are paying for the phone call all the time you are
connected to the Internet (on-line), it is best to compose your mail
messages while you are not connected (off-line) and then go on-line
to deliver them.

To compose an e-mail message

1. Double-click the Message Centre icon  on the Windows 95
desktop, then click EMail.

2. Click New.
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3. In the To box, type the e-mail address of the person to whom
you want to send the message. If you want to send the e-mail
to several people, separate their addresses with semi-colons.

 Alternatively, click the To button to open an address book,
and choose the names of the recipients from among those
listed. (If the person you want is not in the address book, you
can add him now. Click the Help button in the Message
Centre Address Book dialog for more information.)

4. Type the title or subject of the e-mail in the Subject box. Use a
descriptive title so that the person receiving your mail can tell
at a glance what it is about.

5. Type the text of the e-mail in the main part of the window.

6. If you want to attach a file to the e-mail, click Add File and
browse to find it. The name and icon associated with the
selected file are added to the message.

7. When you have finished composing the e-mail, click Outbox
to add the message to the Out tray.

 Alternatively, if you want to leave the message and complete it
later, click Go Back. The unfinished message is added to the
In tray. (To resume editing the e-mail, bring it to the front of
the In tray and click View.)

To deliver the e-mail messages in the Out box

1. Double-click the Message Centre icon on the Windows 95
desktop, then click EMail.

2. Click Deliver.

3. If you are not already on-line, the Message Centre connects to
Infotrade and you are required to logon. In the User Logon
dialog, type your Infotrade Account Number in the User
Name box and your Infotrade password in the Password box.
The Logon Domain box can be left alone.

Note
This assumes that you have subscribed to Infotrade Internet
service. The procedure is similar for other Internet service
providers. Contact your service provider for further information.
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 The Message Centre delivers all the e-mail messages in the Out
box and checks to see if there are any new (incoming)
messages.

4. Click OK when this operation completes.

Outgoing mail is removed from the Out tray once it has been
delivered, but the Message Centre keeps a copy of it until you
decide to delete it. To view sent mail, click Sent mail in the Email
window.

For more information about the Message Centre, click the Help
button in its main window.

Q Can I edit a message after I’ve put it in the Out tray?

Yes. Bring the message to the front of the Out tray and click on the
message. When asked if you want to cancel the delivery, click Yes.
You can then edit the message and either return it to the Out tray
by clicking Outbox or put it in the In tray by clicking Go Back.

Q How do I receive e-mail?

If you subscribed to the Infotrade Internet service, every time you
go on-line you are told if you have any e-mail awaiting collection.

To transfer e-mail from Infotrade to your PC

1. Double-click the Message Centre icon  on the Windows 95
desktop, then click EMail.

2. Click Deliver.

 If you are not already on-line, the Message Centre connects to
Infotrade and you are required to logon as described earlier.
The Message Centre collects your incoming mail and puts it in
the In tray.

3. Click OK when this operation completes.

4. To view the e-mail at the front of the In tray, click View.

5. To reply to this e-mail, click Reply. Otherwise, click Go Back
to return to the Email window.
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